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Introduction 

The purpose of this document is to provide guidance on how to use basic functions of 
Trimble Business Center – HCE (Trimble) Version 5.4 to calculate earthwork quantities 
for Final Estimates purposes. 

All graphics shown in the User Guide are from Trimble Version 5.4; however, the 
procedures to use these basic functions should be similar for all versions. It is the user’s 
responsibility to learn the necessary functions for the applicable version which is being 
used. See the Additional Trimble Resources section for further guidance.  

Software Information 

Software Download 

1. FDOT Users: Submit an Information Resource Request to have Trimble 5.4 
installed to your computer and contact the State Final Estimates Office to gain 
access to the license server. 

2. Consultant Users: Contact a Trimble representative to discuss license options and 
purchase a license that suits your needs. 

Software Updates 

Updates to the software can be through the application directly (see below). 

1. Select Support, then Check for Updates. 

 
2. In the pop-up menu, check the box next to the appropriate update and select 

Install Updates. Follow the Instructions provided. 

Opening the software 

The software can be opened by double clicking the Business Center - 
HCE Powered by Trimble icon installed on your desktop. 

Licensing 

Consultant Users: See Software Download above. 

FDOT Users: The State Construction Office has nine (9) licenses available for use 
across the state. When your Trimble software is installed, it will be pointed to the SCO 
license sever. Each time you open Trimble it will look at the server to determine if a 

mailto:CO-FinalEstimateSection@dot.state.fl.us?subject=REQUEST:%20Trimble%20License
https://construction.trimble.com/products-and-solutions/trimble-business-center
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license is available. You can verify on the Support tab in the License Manager, whether 
you were assigned a license. 

 

Assigned a license: system will identify Survey Advanced is enabled. 

 

No licenses are available: system will identify the unlicensed features. 
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If no licenses are available, submit a Support Ticket for assistance. 

  

https://scos.fdot.gov/
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Menu 

Updating the Ribbon 

This step is optional and only needs to be done with the first load of each 
download/update. 

Trimble has an extensive array of licenses that can be purchased to perform many 
different functions. Many of the ribbon buttons are not necessary and will either be 
grayed out or, when clicked, will pop up with a box to purchase a new module.  

In order to simplify the FDOT user experience, the Department has created a 
customized FDOT ribbon that can be downloaded from the FDOT Trimble Resource link 
and imported into Trimble. This will reduce the number of tabs available, leaving only 
the ones required to perform functions needed by FDOT. 

1. After downloading the FDOT Custom Menu file, right click anywhere on the 
ribbon, then select Customize the Ribbon. 

 

http://www.fdot.gov/construction/eConstruction/Trimble.shtm


Trimble Business Center - HCE Handbook  4/1/2021 

8 | P a g e  

2. Select Import, then navigate to and select the FDOT Custom Menu file and click 
Open, then OK.  

 
3. When imported, the menu should resemble the figure below.  

 

Setting the Template Folder 

From the FDOT Trimble Resource link, download the Florida Templates (East 901 
Datum, West 902 Datum, and North 903 Datum). Extract from the zip files, as needed. 

http://www.fdot.gov/construction/eConstruction/Trimble.shtm


Trimble Business Center - HCE Handbook  4/1/2021 

9 | P a g e  

1. Select Project, then Options. 

 

2. Select File Locations 
3. Select the ellipsis next to Template folder.  
4. Navigate to the folder where you stored the template files, select OK. 
5. Select OK again. 
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Starting a New Project 

1. Select File. 

 
2. Select New. If you don’t see the template you need in the list, refer to Setting the 

Template Folder. Select the appropriate Datum Template for your project, then 
select OK. 
 
NOTE: Multiple Templates will appear in the selection list. It is recommended to 
identify one of the FDOT Templates as the Default. 
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NOTE: Check the map below to ensure you are using the correct Datum.  
Datums run along county lines. (Click map for larger view.)  

 

http://www.fdot.gov/geospatial/maps/Zones_Districts.pdf?rev20170829
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Updating Project Settings 

Modifying the Project Settings will help with 
identifying projects and reports  

1. Select Project, Project Settings.   
 

2. Update the General Information 
(Reference Number [Contract/Project 
Number(s)], Project Name, Description), 
Company Information, and User 
Information. 
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3. If the FDOT templates are not used, review the other project settings to ensure 
the units are correct and align with the survey information to be imported into the 
file.  

a. Make sure the duplicate point tolerance is set at the smallest spacing 
option at 0.001mm.  This setting can be changed by following the 
screenshot below. 

 

 
NOTE: Once your information is added to the project settings, you can save the 
template as your own by selecting File > Save Project As Template to avoid entering in 
this information each time you start a new project. 
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Importing Files 

1. On the Project tab, select Import. Under Import Folder, select the ellipsis […] next 

to the folder location box. Navigate to the folder where your project files are 

located, then select OK. 
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2. On the Import tab, select the files to import, 
then select Import.  

NOTE: Use only LandXML Format, if 
possible. If .txt or .xyz files are needed for 
field data, use the Import Format Editor to 
create a new format specific to the file.  

3. On the Import Conflicts screen, select 
Triangle-based definition, then Import. 

• Definition of Point/Breakline-based 

Point/Breakline-based means the points, 
breaklines, boundaries, and contours in 
the LandXML file are used by Trimble to 
create the surface. This data defines the 
surface, but the data can be modified, if 
needed. 

• Definition of Triangle-based 

Triangle-based means only the triangles 
used to define the surface are imported. 
This data becomes the surface and it 
can no longer be edited. This method 
can be used as a quality control, if the 
“Both definitions” option is chosen. 

 
NOTE: It is 
recommended to 
use the Triangle-
based option to 
ensure the same 
triangles the 
Engineer of 
Record used to 
determine 
quantities are used 
in Trimble. 
Allowing Trimble to 
create triangles 
with the 
Point/Breakline-
based option 
opens the data up 
for potential for 
errors and 
conflicts. 
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4. Select the surface, then right click the surface, then select properties. On the 
Properties pane, set the classification appropriately (Design, Original, As-built, 
etc.). This will ensure Trimble calculates cut and fill correctly. Optionally, set a 
surface color to help distinguish surfaces in your project 

  
 

5. Repeat as necessary to import all pertinent files. 
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Import Format Editor 

The import editor is used when you need to define how Trimble reads a file.  

NOTE: GPS survey data collected in the field is typically provided in txt files that require 
you to understand the format and data included in the file before importing into Trimble. 
You need to know how the data is delimited (separated). Common separators are 
spaces, commas, or tabs. You also need to know what data is included. Typically, there 
is a Point ID, which is information to help identify where the point is located, as well as 
the Northing, Easting, and elevation for each point. The Northing, Easting, and elevation 
give the XYZ coordinate for each point, so that it can be located geographically. 
Sometimes the Easting comes first, so you need to know your dataset to import it 
correctly. Switching the northing and easting columns will orient your project incorrectly, 
which is a clear indicator you imported your file inaccurately.  

• Example Survey file 
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Importing a .txt file 

1. Select the down arrow below Import and select Import Format Editor 

 

2. On this screen, select New and name your Definition. 

 

3. Select Test to open the import preview. This will help you see your formatting 

applied to your data.  
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4. Select the ellipsis […] to select your file. 

 

5. Navigate to your file location, select your file and select open. 
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6. Then select Next. 

 

7. Select Delimited, then Next. 
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8. Select the option for how your file is delimited and select the option to store the 

data as a surface. Optionally, identify the default file extension that will use this 

import format, then select Next. 

 

9. On this screen, add the fields for your dataset (i.e. Point ID, Northing, Easting, 

Elevation) in the order they are in your file. Repeat until your fields are correct. 

Use the import preview to verify your selections. 
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10. Then Select the units - US Survey Foot, then Select Import. 

 

11. Trimble will ask if you want to save the changes to this definition after import. 

Select Yes. That will leave your definition as an option for you to choose next 

time you need to import similar data. 

Naming Conventions 

Ensure all Trimble files and new features (surfaces, corridors, layers, etc.) within 
Trimble have descriptive titles (subsoil, final, intermediate, etc.) along with the Contract 
Number and Financial Project Number. 

Example Trimble File Submittal Naming Convention: T1234_987651-1-52-01.vce 

Example Surface Naming Convention: T1234_987654-1-52-01_Subsoil_Final.xml 

Example Layer Name: Subsoil_Final 

Viewing the Flags Pane 

The Flags Pane shows import or computation errors. Flagged objects should be 
analyzed to see why the objects were flagged and if it warrants further attention. 

To view the Flags Pane, click the  icon in the status bar across the bottom of the 
screen. 
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When reviewing the Flags pane, double click on any line item and 
it will take you to where the error is located in the model. Flags 
within your project will identify the location of each error as well.  

NOTE: The Flag pane only shows the top 100 flags for each 
surface in the model. As you resolve flags, more flags may 
appear until you eliminate all the flags. Typical flags will be found 
where two surface breaklines cross but have different elevations 
for the same location. Trimble will form a surface model and 
assume that one of the two options is correct and will flag the difference. Trimble may 
assume that the wrong one is correct, so it is the user’s responsibility to ensure that the 
model is correct. 

Calculating Surface to Surface Volumes (No Boundary) 

This method of generating an Earthwork Report will calculate earthwork quantities 
without a user defined boundary; thereby making the default boundary limits equal to 
the limits of the outer boundaries of the surfaces being compared. 

• Definition of a Surface 

 A surface is generated by connecting data points into triangles to create a 3D 
model. 

1. Select Surface, then Earthwork Report.  
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2. On the Earthwork Report tab, select 
Surface to Surface, select the initial 
and final surfaces (i.e. the 2 
surfaces to compare). 

NOTE: The surface names that 
appear under ‘Initial’ and ‘Final’ are 
the actual names of the surfaces 
(within the surface files) and not 
necessarily the names of the 
surface files that were imported.  

 
a. Typically, you will be 

comparing the design files to 
your pre-construction survey, 
or your design files to your 
post-construction survey. 

b. In the case of subsoil, you 
will be comparing the bottom 
of subsoil excavation to the 
top of fill. You will also need 
to compare the bottom of 
subsoil to the design files to 
see if the tolerances in 
Specifications Section 120-
4.1 were exceeded and 
compare the top of fill to the 
finished grading template, as 
defined in Specifications 
Section 120-2.3. Use the 1:2 
control line shown in Design 
Standard Index 500 to 
determine the limit for 
removal. 
 

3. It is not recommended to use the 
Materials option as it isn’t needed 
for final estimate payment. This 
option can be useful for Contractors 
when determining if material is 
usable in other locations on the 
project. 
 

4. Under Volume Breakdown, select 

your preferred reporting option. 

(See next page for options.) 
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a. Volume totals only – report will give you the amount of cut, fill, and 
excess/shortage.  
(Example below)  

 

b. By depth increment – report will give cut and fill based on the depth 
increment entered, along with the volume totals.  
(Example below is depth increment = 5) 

 

c. By elevation interval, report will give you cut and fill based on the elevation 
interval and index elevation entered, along with the volume totals. 
(Example below is elevation range = 1 and index elevation = 0.) 

 

5. Click OK to generate the Earthwork Report based on your preferred option for 
volume breakdown. 

NOTE: Always review the surfaces and surface classifications being compared to 
ensure that the Cut / Fill quantities are reported correctly. 
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• Example Earthwork Volume Report 

 

Calculating Surface to Surface Volumes (with Boundary) 

It may be beneficial or necessary to generate an earthwork report within isolated areas 
on the project. 
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• Definition of Boundary  

A boundary delineates a portion of a 
surface to limit the calculation to a 
specific area or section of the 
surface. Boundaries can be defined 
by creating/using shapes, polylines, 
or corridors within the project limits.  

1. Follow the steps for Calculating 
Surface to Surface Volumes, but in 
the Boundary cell, select the 
boundary line to limit your calculation, 
then select OK. 

NOTE: The boundary can be various 
shapes (see Create a Circle, Create a 
Rectangle, and Create a Polyline. The 
boundary must be a closed shape to limit 
the calculation correctly. Also, boundaries 
only need to be in 2-D (no elevation 
required). Be aware however, that “no 
elevation” is like 0 elevation, so the 
boundary will be at a different elevation as 
the surface when viewing in 3-D. A 
boundary acts as a “cookie cutter” through 
the selected surfaces and limits the volumes 
computed to that which fall inside of the 
boundary. 

  



Trimble Business Center - HCE Handbook  4/1/2021 

28 | P a g e  

Creating a Circle (for use as a Boundary) 

1. On the CAD tab, select Circle.  

  
2. On the Create Circle tab, name the circle, and assign it to a new layer. 

  
3. In the Layer Manager window, enter a layer name, and select the layer color, line 

style, and line weight, then select Close. 
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4. Optional: Enter the circle Elevation 
or snap to any 3d object to specify 
the elevation. (See Definition of 
Boundary – elevation is not 
required.) 
 

5. Enter a coordinate or select a point 
on the surface as the Center point of 
the circle.  
 

6. Enter the radius or select a point on 
the surface to specify the circle size. 
 

7. Once a radius is selected, the 
Create Circle tab is ready to make a 
new circle. If you are done making a 
circle, select Close. If you need 
another circle, repeat the Create 
Circle steps above.  

NOTE: Once a boundary is created, it can 
be used to generate a surface to surface 
volume report.  

Creating a Rectangle (for use as a Boundary) 

1. On the CAD tab, select Rectangle. 

  

NOTE: The rectangle command creates a rectangle in the N-S, E-W orientation. To 
skew a rectangle, use the pull down on the icon and select 3-point rectangle. This 
allows selection of two points and a width to define the rectangle (See Step 8).  

 

  



Trimble Business Center - HCE Handbook  4/1/2021 

30 | P a g e  

2. On the Create Rectangle tab, name the rectangle, and assign it to a new layer. 

 
3. In the Layer Manager window, enter a layer name, and select the layer color, line 

style, and line weight, then select Close. 
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4. Optional: Enter the rectangle 
Elevation or snap to any 3d object to 
specify the elevation. (See Definition 
of Boundary – elevation is not 
necessary).  
 

5. Enter a coordinate or select a point 
on the surface as Corner one. 
 

6. Enter a coordinate or select a point 
on the surface as Corner two. 
 

7. Once Corner two is selected, the 
Create Rectangle tab is ready to 
make a new rectangle. If you are 
done making a rectangle, select 
Close. If you need another 
rectangle, repeat the Create 
Rectangle steps above.  
 
 
 
 

8. For a Three-Point Rectangle, select 
the width and then Close.  

NOTE: Once a boundary is created, it can 
be used to generate a surface to surface 
volume report.  
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Creating a Polyline (for use as a Boundary) 

1. On the CAD tab, select Polyline.  

 
2. On the Create Polyline tab, name the polyline and assign it to a new layer.  

  
3. In the Layer Manager window, enter a layer name, and select the layer color, line 

style, and line weight, then select Close. 
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4. Select Always to automatically close 

by connecting ends, since the 
boundary needs to be closed.  
  

5. Select the appropriate Method to 
Add Points.  

• Definition of Specify Individual 
Points 

The start and end points for each 
segment can be selected. 

• Definition of Stream points  

The first point of the polyline can be 
selected, then points are selected as 
you move along the path with the 
mouse button down based on the 
filter settings.  
 

6. The last option of the Create Polyline 
tab is dependent upon the selection 
for Method to Add Points. Add points 
and then Close. 

NOTE: Once a boundary is created, it can 
be used to generate a surface to surface volume report.  

Viewing Cross Sections 

First, you must have a corridor with an alignment to create cross sections. Design files 
will come with a corridor and alignment already defined. If you have a project that does 
not have a corridor and alignment, you will need to create them (See Creating an 
Alignment and Creating a Corridor). 

1. Select Corridor, then Cross-Section View. You must have an alignment selected 
for the Cross-Section View icon to be selectable. 
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2. At the bottom of the screen, type in the station value or move the slider to the 
station to view. Use the yellow wheel icon, to change the station interval. 

 

Creating an Alignment 

• Definition of Alignment 

An Alignment defines the path or route of a road based on a series of tangents 
and curves. There are two alignments for every road – the horizontal alignment 
and the vertical alignment. The horizontal alignment typically follows the 
centerline of the road. The vertical alignment follows the horizontal alignment, but 
indicates the elevation to show whether you are going up or down a hill. 

If the designer provided an Alignment file in the CADD.zip file, you don’t need to 
create an alignment. Skip this step and use the Import instructions to add it to 
your Trimble project. 

1. Select Corridor, Create Alignment. 
 

 
2. Enter the name of the alignment and select the layer on the Create Alignment 

tab. 
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3. Select the applicable Horizontal 
Geometry Definition, then select OK.  

• Definition of Inscribe curves at PIs 

This option builds the alignment from 
data with values for curves at 
consecutive Points of Intersection 
(PIs). 

• Definition of Define individual 
segments 

This option builds the alignment from 
data with values for consecutive line, 
arc, and spiral segments or to build 
an alignment based on the geometry 
of an existing line. 

 

 

 

 

 

Adding Station Labels to Alignment 

1. On the Corridor tab, select Create Labels. 
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2. On the Create Horizontal Alignment Labels, select the alignment, then select 
Label Settings. 

 
3. Identify your tick mark spacing. 
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4. Choose/Create a layer for both the Ticks and the Text, then select OK. 

 
 

5. Un-select the Display whole station (if applicable) box to ensure the + is shown in 
the station display for all station values, then select OK. 
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6. Select OK. 

 

NOTE: If need adjust other settings so text is appropriate size and font. 

Creating a Corridor 

• Definition of Corridor 

A Corridor is a 3D model of a road based on the horizontal and vertical 
alignments identified. 

1. On the Corridor tab, select Create Corridor.  

 
 

2. On the Create Corridor tab, name the corridor and select the horizontal 
alignment. Select the appropriate original ground file and check the same original 
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ground file in the “reference surfaces” 
section at the bottom of the window, 
click OK.  

NOTE: It is not required to select a vertical 
alignment or native and fill materials. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

3. On the Insert Corridor Template tab, 
select a beginning station for the new 
corridor and click Insert.  
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4. On the next tab, under Instruction 
Type, select Surface. 
 

5. Under Instruction Details, select the 
surface.  
 

a. Typically it is the Original 
Ground/Existing surface, 
however, if you want to 
compare volumes between 
Last Month and This Month, 
then Last Month can be 
selected as the existing and 
This Month set as the finish 
surface. 

 
6. Under Material layers, ensure the 

Finish box is not checked, and select 
Add.  
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7. On the next tab, under Instruction 
Details, select the surface to 
compare with the original ground.  
 

8. Under Material Layers, select the 
Finish box. 
 

9. Click Add, then Close.  
 

10. Type in a station or move the slider 
along the corridor to see cross-
sections. Cut and Fill areas will be 
identified. 
 

11. Click Close. Once the Edit Corridor 
Template is closed, the station slider 
will also close. 
 

NOTE: It is now possible to generate 
Corridor Earthwork Reports along the 
corridor. 
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Generating a Corridor Earthwork Report (with Option for Subsection/ 
Between Stations) 

1. On the Corridor tab, select Corridor Earthwork. 

 
2. Choose appropriate corridor for 

analysis.  
 

3. Specify station increment.  
 

4. Optional Clipping Boundaries will be 
automatically set to “Selected: 1”. 
Ensure it is set to “Selected: 0”.  
 

5. To produce the Corridor 
Earthwork Report for a specific 
section of the project, enter the 
start and end station values for the 
section to be analyzed. 
 

6. Uncheck the horizontal and vertical 
points to produce earthwork 
quantities only for the specified 
increments, and click OK.  
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7. A new screen will open, and the Corridor Earthwork Report will be generated.  

 

• Example Corridor Earthwork Report 
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Additional Trimble Resources 

FDOT Trimble Webpage 

http://www.fdot.gov/construction/eConstruction/Trimble.shtm 

This link is the FDOT Trimble webpage. Additional information and Frequently Asked 
Questions will be posted here. 

Trimble Help and Geospatial Community 

It is recommended to take advantage of the built-in Help menu and Geospatial 
Community. These resources are great for more information on how to perform 
functions in Trimble. 

 

Trimble YouTube 

Trimble also has detailed videos posted on their YouTube channel: 
https://www.youtube.com/user/TrimbleHelpBCHCE  

Tips and Tricks 

• Designer Surfaces 

Surfaces with Poor Quality 

Designers are required to provided 3D files per the CADD Manual and should create 
them using the FDOT Roadway Design and 3D Modeling User Training Manual 
(Chapter 10). If you receive 3D files that have extraneous triangles (webs) from the 
designer, send the files back to the designer for correction immediately. The examples 
below show what clean and poor-quality surfaces look like:

http://www.fdot.gov/construction/eConstruction/Trimble.shtm
https://www.youtube.com/user/TrimbleHelpBCHCE
http://www.fdot.gov/cadd/downloads/publications/CADDManualFDM/default.shtm
http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm
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Surface without webs (clean, break lines)  Surface with webs (poor, no break lines) 

                            

Surfaces Not provided 

If you don’t receive surfaces for your project, contact the designer immediately. The 
designer must provide 3D files (per the current CADD Manual) or GEN files (per the old 
CADD manual). 

• Field Survey Data 

It is very important to understand and know your field survey data. Before you use your 
field survey data in calculation of earthwork quantities, be sure to review the data. You 
must investigate why Trimble created triangles/web between your data points.  

Individual Areas 

It is recommended to make separate files for each subsoil area (or each isolated survey 
area if not subsoil), so Trimble does not create triangles/web between unconnected 
areas.  
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Example 

The picture 1 below shows 2 subsoil areas in one surface file. Trimble interpolates 
triangles between these areas, which will thereby calculate volumes between them as 
well. Leaving the 2 areas together generates a volume of 53,165.0 CY. 

 

Whereas separating each area into its own file like picture 2 and adding each volume 
together generates a volume of 3,480.9 CY.  

 

NOTE:  Another option would be to create a new layer boundary for each area and 
generating the earthwork report using that layer, as the boundary option.  This method 
however, would require choosing the correct boundary points in order to generate 
accurate volumes. (See Definition of a Boundary, in this Handbook for more 
information.) 

 

1 

2 



Trimble Business Center - HCE Handbook  4/1/2021 

47 | P a g e  

If your surveyor provides your survey data for multiple areas within a single file (as 
shown below), you can manually separate the data. Note the stationing is the last data 
entry in the rows.  By looking at the stationing, it can be determined that the blue area is 
near Station 1215+00 whereas the remaining survey data is near Station 1174+80 to 
1176+73. Analyze your data to identify the separate areas (blue highlight vs remaining 
points), then copy and paste each area into its own file. Import the separate files into 
Trimble. 
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Bench Marks 

Bench Marks are very important for validating your survey, but they do not need to 
become part of your surface. As you can see in picture 1, the survey was tied to a 
bench mark, which caused Trimble to create triangles/web (white) to that point. This 
skewed the surface out at that point, adding area that wasn’t part of the surface.  

When the bench mark was removed from the from the survey data in picture 2, Trimble 
was able to create the correct triangles/web (green) for the surface. 

Clean up such as this is required to produce accurate volumes. If your surface “doesn’t 
look right,” it probably isn’t. Use common sense and your gut to validate the surface 
data. Coordinate with your surveyor on any areas that seem “off.” The closer you do this 
to the actual survey the more accurate your surface will be. Delayed analysis can result 
in questions that can’t be answered when the surveyor has forgotten the details of the 
area surveyed. 

 

 

1 2 
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